
 سبأ محمد علوان . د
 أستاذ مساعد قسم الاحصاء وبحوث العمليات 

 جامعة الملك سعود

  SPSSعن طريق الأمثلة والتطبيق باستخدام الحزمة الاحصائية 



 مقدمة

على الرغم من أهمية استخدام الإحصاء في تحليل البيانات للبحوث والرسائل  
العلمية فإن هناك بعض المشكلات التي قد تنشأ عن هذا الاستخدام والتي تكون غالباً بدون 

قصد وبسبب عدم التخصص في الإحصاء لدى البعض وبالتالي عدم الإلمام ببعض الجوانب 
 .العلمية الإحصائية الدقيقة 

وفي هذه الورشة نحاول معرفة التحليل الاحصائي المناسب من خلال طريقة  
سهلة وهي الأمثلة المباشرة والتي تحاكي بعض الحالات  التي قد يكون فيها الباحث  في 

مع ملاحظة اننا نركز على البحوث العلمية وبما هو متاح من الوقت لهذه , مساره البحثي
 .الورشة  
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,  قراءات ومن ثم تعطل الجهاز 30حصلت على , قراءات   40باحثة كانت تجري تجربة وتود الحصول  على  

 عند وصفها للبيانات  . الباقية 10ومن ثم استكملت القراءات ال , حصلت  جهاز جديد 

 ملخص قراءات الجهاز الثاني ملخص قراءات الجهاز الأول
 ملخص قراءات العينة كاملة

 ؟

weighted average
weighted average

= = 
9.5 12.1 

نجمع الوسطين ونقسم على اثنين لا ... الوسط الحسابي للعينتين معا  لحساب 

   .إلا في حالة واحدة فقط وهي إذا كان حجم العينتين متساويين

1 
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Where w mean sample size 
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(  بالكيلوجرام)لقياس الوزن الجدول أدناه يتضمن بيانات إحدى الدراسات التي طبقت على خمسة أشخاص 

 أم بيانات الأطوال؟بيانات الأوزان ( تجانسا  أقل ) أي البيانات أكثر تشت تا (. بالسنتيمتر)والطول 

 :في الحالتين التاليتينالبيانات المختلفة تجانس مجموعات يستخدم معامل الاختلاف لمقارنة 

 .إذا كانت وحدتا المتغيرين مختلفتين حيث لا نستطيع مقارنة الوحدات المختلفة ١.

ينزع لأن يكون المتوسط الصغير لأن تباين توزيع المتغير ذي وذلك . إذا كان متوسطا المتغيرين مختلفين  ٢.

 .بالعكسصغيا والعكس 

 الاختلافمعامل 
2 
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في المجموعات المختلفة المشاهدات المختلفة قيم عديمة الوحدة ولذلك فإنها تستخدم للمقارنة بين هي 

 .الوحدات  والمختلفة المتوسطات

الطالب في وبالتالي أداء 

مقرر الإحصاء أفضل من 

أدائه في مقرر 

الرياضيات بالرغم من أن 

 درجته

في مقرر الإحصاء أقل 

من درجته في مقرر 

 الرياضيات

 3 الدرجات المعيارية
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 الارتباط والانحدار

العلاقات بين المتغيرات 

 “ معاملات الارتباط“

 التنبؤ

 “ الانحدار “

 ت  المتغيرافالارتباط يقيس درجة أو قوة العلاقة بين

 .1+و1-بقيمة رقمية محصورة بين 

 وهناك طرق متعددة لحساب درجة الارتباط بين

 :متغيرين

إذا كان  بيرسونعلى سبيل المثال معامل ارتباط -

 المتغيران كميين ،

إذا كان المتغيران كميين أو  سبيرمانمعامل ارتباط -

 (.ترتيبين ، أو أحدهما كمي والآخر ترتيبي 

 الانحدار يعبرّ عن هذه العلاقة بمعادلة رياضية خطية  (

بقيم المتغير التابع  التنبؤتفيد في ( أو غير خطية 

(  أو المتغيرات ) بافتراض قيم معينة للمتغير 

 .المستقلة

 المتغير مدى تأثير الانحدار يفيد أيضا في تحديد

لتكن معادلة : مثلا.المستقل على المتغير التابع 

 ...فما هو تأثير ...... لالانحدار 
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 : ، وقد صنف بعض الإحصائيين درجات لقوة العلاقة يمكن تمثيلها على الشكل التالي(•

  اتفيصنت
 
 : قوة العلاقةخرى  لا
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  : اليومي بالدينار والمبينة في الجدول الآتي( Y)والإنفاق ( X)أوجد معامل الارتباط بين دخل تسعة أسر : 

X 6 8 7 14 11 12 8 9 10 

Y 4 8 6 10 9 11 8 7 8 

 

: مثال  
4 

 2010 2009 2008 2007 2006 2005 2004 2003 2002 2001 2000 السنة

 206.2 153.3 106.6 100 97.6 89.6 79.2 55.7 53.8 53.7 51.7 الوقود

 136 119.8 107.7 100 93.9 88.8 81.4 73.3 69 66.8 64 السلع

 :  مثال
 

 سنة  11يبين الجدول التالي نسبة التغير في أسعار الوقود و في أسعار السلع و الخدمات الأخرى لمدة 

 أوجد معامل الارتباط بين المتغيرين 
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A F D C A  تقدير الإحصاءX 

A D B C B  تقدير الرياضياتy 

اخترنا , وجود علاقة بين تقدير الطالبة في الإحصاء و تقديرها في الرياضيات  إدرسس

 :خمس طالبات و كانت تقديراتهم كالتالي

 6 مثال

 أنثى ذكر  

 2 10 يدخن

 5 8 لا يدخن

 :مثال

    .  

لمعرفة العلاقة بين الجنس والتدخين فجمعت البيانات في   شخص 25في دراسة على  7

 الجدول التالي والمطلوب هل هناك ارتباط معنوي بين الجنس والتدخين
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 معاملات الارتباط

 بيرسون

 كلا المتغيرين كمي -1

و كلا المتغيرين  -2
ينحدران من مجتمعات 

 طبيعية

و العلاقة المراد  -3
تقديرها هي علاقة 

 خطية

 سبيرمان

 الرتبي

 متغيرات رتبيه -1

 +أو  متغير كمي -2

 متغير اسمي في مستويين

أو المتغيرات من  -3
مجتمعات لا يعرف 

 توزيعها

  يفضل استخدامه اذا كانت
 10حجم العينة أكبر من 

 كيندال

 متغيرين كميين -1

أو متغيرين وصفيين 
 ترتيبين

أو المتغيرات من  -2
 مجتمعات لا يعرف توزيعها

  يفضل استخدامه اذا كانت
 10حجم العينة أقل من 

بوينت 
 بايسيريال

لقياس الارتباط يستخدم 
و متغير  Xبين متغير كمي 

–نعم )مستويين Yاسمي  
و ( أنثى –ذكر )أو ( لا

 .غيرها

اشارة معامل الارتباط ليس 
لها معنى في حالة 

المتغيرات الوصفية فتقاس 
قوة العلاقة و ليس 

 .اتجاهها

 11 

 معلمي
 معلميةلا 

Saba Mohammed Alwan 

Statistical and O.R 

Faculty of Science. KSU 

salwan@ksu.edu.sa 



12 

  : اليومي بالدينار والمبينة في الجدول الآتي( Y)والإنفاق ( X)أوجد معامل الارتباط بين دخل تسعة أسر : 

X 6 8 7 14 11 12 8 9 10 

Y 4 8 6 10 9 11 8 7 8 

 

 مثال 

انقل المتغيرين المراد معرفة معامل الارتباط 

 بينهما 

Person, two tails, Flag 

significant correlation  

Analyze → Correlate → Bivariate → Options → 

Continue  

للحصول على متوسطات 

وانحرافات المتغيرات 

 المختارة

أنه لا توجد علاقة بين المتغيرين بل لا توجد  لايعنيإذا وجد أن معامل ارتباط بيرسون تساوي صفر فهذا 

 كما أن الارتباط لا يعني السببية , علاقة خطية

أن يكون التوزيع لكلا المتغيرين اعتدالي وأن تكون العينة  لبيرسونيشترط عند حساب معامل الارتباط 

 (.  استقلالية أفراد العينة) عشوائية وقيم الفرد لا تعتمد على قيم فرد آخر

أو  سبيرمانمعامل ارتبط )وفي حالة عدم اعتدالي المتغيرين نستخدم معامل ارتبط آخر سيذكر في حينه 

 تاو"كندال

Pearson Linear Correlation Coefficient 

 للارتباط الخطي بيرسونمعامل 

4 

Saba Mohammed Alwan 

Statistical and O.R 

Faculty of Science. KSU 

salwan@ksu.edu.sa 



1 

5 
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3 

Analyze         Descriptive Statistics          Explore  
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 الطبيعية إختبار

 البيانات تتبع التوزيع الطبيعي : العدم فرضية 

 البيانات لا تتبع التوزيع الطبيعي: الفرضية البديلة 

Normality Test 
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وهي أكبر من 

0.05 

إذن نقبل الفرضية 

أن البيانات تتوزع  

 طبيعيا

 البيانات تتبع التوزيع الطبيعي : العدم فرضية 

 البيانات لا تتبع التوزيع الطبيعي: الفرضية البديلة 
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 Normality Test الطبيعية إختبار



 H1 : ρ ≠ 0 (Two tails test  توجد علاقة أي   مقاب      Ho : ρ = 0: لا توجد علاقة  :الاختبار هنا 15

ونقبل الفرضية  خطية فنرفض الفرضية الصفرية بعدم وجود علاقة 0.01بمستوى معنوية  r = 0.877نجد أن  ةناتج المبينالمن 

 0.01خطية  دالة احصائيا عند مستوى دلالة  البديلة بوجود علاقة

 إيجاد معامل الارتباط
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حد التفسيرات السهلة الفهم لمعنى الدلالة الاحصائية
 
 .ا

 

مرة 100فان هذا يعني اننا لو اعدنا هذا البحث او هذا الاختبار ، 0.05عندما نقول هذا دال عند مستوى اننا  -

، وسوف تكون نسبة الخطاء في ان نحصل على نتيجة مختلفة مرة 95سوف نحصل على نفس النتيجة  فاننا

 (0.05اي ) هو خمسة مرات من اصل المئة 

 

تعني اننا لو اعدنا تطبيق هذا البحث او هذه التجربة الف  لانهاالاقوى، هي 0.000فان نسبة الدلالة وبالطبع  -

 .في مقابل مرة واحدة خطاءمرة 999سوف نحصل على نفس النتيجة  فاننا( مرة1000) مرة 

 

 .   الصدفةأن يحدث عن طريق بنسبة جدا  المستبعد من  -

 .وكذا  وجود فروق بين مفردات العينة تماما كما هي في المجتمع, تتأثر المعنوية بعدد الحالات التي في العينة

بالخطأ المسموح به والمحدد المحسوب  من البيانات مقارنة كما أنه ممكن النظر لها على أنها مقدار الخطأ 

وعليه كلما قل الخطأ المحسوب من البيانات مقارنة بالخطأ النظري المسموح به كلما دل على دقة , سلفا

 الدلالة المحددالنتائج عند مستوى 
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 2010 2009 2008 2007 2006 2005 2004 2003 2002 2001 2000 السنة

 206.2 153.3 106.6 100 97.6 89.6 79.2 55.7 53.8 53.7 51.7 الوقود

 136 119.8 107.7 100 93.9 88.8 81.4 73.3 69 66.8 64 السلع

 :  مثال
 

 سنة  11يبين الجدول التالي نسبة التغير في أسعار الوقود و في أسعار السلع و الخدمات الأخرى لمدة 

 أوجد معامل الارتباط بين المتغيرين 

5 

إذا ما كانت البيانات لها نختبر ...حيث أن العينة صغيرة ولا نعلم ان كان المجتمع طبيعيا ام لا
 Shapiroاختبار  باساخدامتوزيع طبيعي 

 البيانات لها توزيع طبيعي : فرضية العدم 1.
 الفرضية البديلة البيانات لا تتبع التوزيع الطبيعي -2       
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 Shapiro      اختبار  باساخدامنختبر إذا ما كانت البيانات لها توزيع طبيعي 

 البيانات لها توزيع طبيعي : العدم فرضية 

 البيانات لا تتبع التوزيع الطبيعي : الفرضية البديلة

لذلك نرفض فرضية العدم و نقبل الفرضية  0.05في المتغيرين أقل من  الدلالىنجد أن قيمة مستوى 

 البديلة 

 تتبع التوزيع الطبيعي ،  لا أي أن البيانات) 

 لذلك

 لا معلمي نستخدم اختبار  
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1 

2 

3 

4 
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Correlations 

نسبة التغير في   

 نسبة التغير في السلع و الخدمات  الوقود 

Kendall's tau_b  نسبة التغير في
 الوقود 

Correlation 

Coefficient 

1.000 .891** 

Sig. (2-tailed) . .000 

N 11 11 

نسبة التغير في السلع 
 و الخدمات 

Correlation 

Coefficient 

.891** 1.000 

Sig. (2-tailed) .000 . 

N 11 11 

Spearman's rho  نسبة التغير في
 الوقود 

Correlation 

Coefficient 

1.000 .964** 

Sig. (2-tailed) . .000 

N 11 11 

نسبة التغير في السلع 
 و الخدمات 

Correlation 

Coefficient 

.964** 1.000 

Sig. (2-tailed) .000 . 

N 11 11 

**. Correlation is significant at the 0.01 level (2-tailed). 

 :للرتب نجد أن  سبيرمانو معامل  كندالبتطبيق معامل 

 0.01علاقة طردية قوية بين المتغيرين و هو دال احصائيا  في مستوى أي وجود  0.891=  كندالقيمة معامل 

   0.01علاقة طردية قوية جدا  بين المتغيرين عند مستوى دلالة  أي وجود  0.964= للرتب  سبيرمانقيمة معامل 

0 



A F D C A  تقدير الإحصاءX 

A D B C B  تقدير الرياضياتy 

اخترنا خمس طالبات و كانت , وجود علاقة بين تقدير الطالبة في الإحصاء و تقديرها في الرياضيات  إدرسس

 :تقديراتهم كالتالي

هل يمكن حساب معامل 

 بيرسون
 لا يمكن لأن المتغيرات ليست كمية

 مثال

21 

6 

Saba Mohammed Alwan 

Statistical and O.R 

Faculty of Science. KSU 

salwan@ksu.edu.sa 



22 

 هل توجد علاقة ارتباط؟ ما نوعها ومدى قوتها؟

 نستخدم معامل سيبرمان لارتباط الرتب

 .إذا كان قياس المتغيرين كليهما مقياس ترتيبي 

Spearman Rank Correlation Coefficient 

A B C D F 

5 4 3 2 1 

 نعطي لكل تقدير رقم مقابل
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Analyze----correlate------ Bivariate 
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 0.05متوسطة ذات دلالة احصائية  عند مستوى دلالة  طرديةعلاقة  يوجود.. وعليه 

 بين تقديرات الطلاب في مادة الإحصاء وتقديراتهم في مادة الرياضيات

هل هذا التعبير 

 صحيح؟

Saba Mohammed Alwan 

Statistical and O.R 

Faculty of Science. KSU 

salwan@ksu.edu.sa 



26 

 أنثى ذكر  

 2 10 يدخن

 5 8 لا يدخن

 :مثال

لمعرفة العلاقة بين الجنس والتدخين فجمعت البيانات في الجدول التالي   شخص 25في دراسة على     

.والمطلوب هل هناك ارتباط معنوي بين الجنس والتدخين  

هل يمكن حساب معامل 

 لا يمكن لأن المتغيرات ليست كمية بيرسون

 .لا يمكن لأن المتغيرات ليست ترتيبية سبيرمانهل يمكن 

7 
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 SPSSباستخدام  فايخطوات ايجاد عامل ارتباط 
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 .القيمة  تدل على ضعف العلاقة بين الجنس والتدخين 

وليس اتجاه (  قوية/متوسطة/ضعيفة)قوة العلاقة فقط  الىعند تفسير نتيجة معامل الاقتران ننظر : ملاحظة
 !فكيف تزيد أو تنقص  ولابالرتبيةوهذا منطقي فالمتغيرات ليست بالكمية ( عكسية/طردية)العلاقة 
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 رتبي اسمي كمي

 (معامل بيرسون) كمي

 

معامل الارتباط ) 

,  ايتامعامل , التسليلي

 (.ايبسلونمعامل 

 

معامل الارتباط )

 (.المتعدد المتسليل

معامل , معامل كرايمر  اسمي

,  معامل التوافق, فاي

 (لامدامعامل 

 

معامل , معامل فيتا

 (الثنائي للرتب

معامل , سبيرمانمعامل  رتبي

 (.كندالمعامل , جاما

 

 معاملات الارتباط حسب نوع المتغير
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 :معامل الارتباط المتعدد

 :الفرضية

 هل توجد علاقة بين المواد المختلفة؟    

8 
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  SPSSنستخدم برنامج   

 :كما موضح في الشكل التالي: الخطوة الأولى

  Analyze → Correlate → Bivariate → Options → Continue  
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Correlations

1 .959** .780** .833**

. .000 .008 .003

10 10 10 10

.959** 1 .746* .811**

.000 . .013 .004

10 10 10 10

.780** .746* 1 .890**

.008 .013 . .001

10 10 10 10

.833** .811** .890** 1

.003 .004 .001 .

10 10 10 10

Pearson Correlation

Sig. (2-tailed)

N

Pearson Correlation

Sig. (2-tailed)

N

Pearson Correlation

Sig. (2-tailed)

N

Pearson Correlation

Sig. (2-tailed)

N

رياضيات

ء احصا

اد اقتص

اسبة مح

رياضيات ء احصا اد اقتص اسبة مح

Correlation is signif icant at  the 0.01 level (2-tailed).**. 

Correlation is signif icant at  the 0.05 level (2-tailed).*. 

 :فنحصل على المصفوفة التالية
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في المثال السابق يشك الباحث في أن هنالك تأثير لفهم أحد الفروع على 

 فماذا يعمل ؟ ..  الآخر لوجود تشابه في المفردات أو القدرات المطلوبة للفهم 

إن معاملات الارتباط السابقة ليست دقيقة وصافية للعلاقة بين كل متغيرين فيعتبر كل 

 .واحد منهم دخيل على الآخرين فقد يضخم أو يقلل معامل الارتباط بينهما

 9 مثال 

 : ملاحظة
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 الآن نقوم بإيجاد معامل الارتباط الجزئي عن طريق المسار

Analyze → Correlate → Partial→ 

 :يظهر مربع الحوار التالي Partialومن القائمة الفرعية اختر 

في " الجنس " ومتغير  Variablesداخل المستطيل " إحصاء "  و" رياضيات " ادخل المتغيرين 

 Okثم اضغط على زر . :Controlling for اسفلالمستطيل 

 كما يلي 
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 :فنحصل على النتائج التالية

 احصاء رياضيات 

  0.9588  1.0000 رياضيات

P= .000 

  1.0000  0.9588 احصاء

Partial Correlation Coefficients 

Controlling for..    الجنس 

 لان قوية والإحصاء الرياضيات علامة بين العلاقة أن نستنتج السابقة النتائج من

2- tailed significance = 0.000 ونقبل الصفرية الفرضية نرفض أي0.05  من اقل وهي  

  الجنس تأثير عزل بعد والإحصاء الرياضيات علامة بين إحصائية دلالة ذات ارتباط بوجد

 له المعزول المتغير أن يعني هذا فإن ما متغير عزل بعد ارتفع إذا متغيرين بين الجزئي الارتباط معامل أن •

 .المتغيرين بين الارتباط معامل على سلبي تأثير

 تأثير له المعزول المتغير أن يعني هذا فإن ما متغير عزل بعد الجزئي الارتباط معامل قيمة قلت إن كذلك •

 .المتغيرين بين الارتباط معامل على موجب

 في كان كما تأثير له ليس المعزول المتغير أن يعني هذا فإن معنوي فرق لايوجد أو متساويين كانا إذا أما •

   السابق مثالنا

 :الفرضية الصفرية

 ارتباط بين  لا يوجد 

علامة الرياضيات  

 والاحصاء 

 

:  البديلة الفرضية 

ارتباط بين  يوجد

علامة الرياضيات 

   والإحصاء

   والإحصاء



 الانحدار الخطي البسيط 
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أما إذا كان المطلوب معرفة مدى تأثير متغير مستقل على 

بقيم المتغير التابع عند تحديد قيم معينة  التنبؤمتغير تابع أو 

 .للمتغير المستقل فإن تحليل الانحدار يكون هو المناسب 



فإذا كان , يتم إعطاء العجول كميات من البروتين اليومي بغرض زيادة في الوزن, مزرعة للعجول    

 فما هي كمية البروتين اليومية اللازم إعطاءها له؟,  كجم 18المطلوب زيادة في  وزن العجل الرضيع 
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 كمية البروتين 10 11 14 15 20 25 46 50 59 70

 الزيادة في الوزن 10 10 12 12 13 13 19 15 16 20

 :  معادلة الانحدار المقدرة، هيفإن كمية البروتين،  هي مقدار الزيادة في الوزن،   x بفرض أن  هي

xy 143.044.9ˆ 

 :المعادلةلهذه تفسير لابد من 

 مثال

ن كمية البروتين اليومي التالية التي تعبر بيانات قام الباحث بالتجريب على عينة  من العجول  وحصل على ال  الحل

،  وذلك لعينة من العجول الرضيعة بالكجمبالجرام التي يحتاجها العجل الرضيع، ومقدار الزيادة في وزن العجل 

 10 حجمها 

44.90  : الثابت•
ˆ   يدل على أنه في حالة عدم استخدام البرروتين قري التغذيرة، فرإن

 .كجم 9.44الوزن يزيد 

143.01  : معامل الانحدار
ˆ  : يدل على أنه كلما زادت كمية البروتين جرام واحد، حدث زيادة

   143زيادة مقدارها  أىكجم،  0.143في وزن العجل بمقدار 

  .جرام

10 
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 :الزيادة في الوزن فإن  55x إذا كانت كمية البروتين•
305.17)55(143.044.9ˆ y

 :الزيادة في الوزن فكم ستكون  85x إذا كانت كمية البروتين•

)85(143.044.9ˆ y

المجةال  المجال حيث تم تقدير هذه المعادلةة  فةي هةذا ضمنلأنها قيمة خارج المجال والصحيح أن نتنبأ بقيم 
 أما في قيم خارج المجال فإننا نحتاج للسلاسل الزمنية وتحديد معادلة الاتجاه العام

   فما هي كمية البروتين اللازمة للحصول على هذه الزيادة 18مقدارها زيادة في الوزن إذا أردنا 

xy 143.044.9ˆ   البروتين 
 زيادة في الوزن  كمية 

?143.044.918  xx

87.59x
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